Excel Project 4

Two of the more powerful aspects of Excel are its wide array of functions and its capability to organize answers to what-if questions. In earlier projects you were introduced to several functions. In this exercise, you will learn about financial function by doing a loan analysis.

1. From the Start menu select New Office Document. If necessary, click the General tab and then double-click Blank workbook.
2. Click the Select All button above row heading 1 to select the entire workbook.
3. Click the Bold button to set the entire workbook to bold font.
4. In cell B1 type **WeSavU National Bank** as the section title and press <Enter>.
5. Select the range B1:E1. Click the Merge and Center button to center the title across those columns.
6. With cell B1 active, change the font size to 16 and the font color to Red.
7. Drag through row headings 1 and 2 and then, with both rows selected, position the mouse pointer on the bottom boundary of row heading 2. Drag down until the ScreenTip, Height: 27.00 (36 Pixels), displays.
8. In cell B2 type **Date**.
9. In cell C2 enter the formula =now().
10. Right click cell C2 and then click Format Cells on the shortcut menu. Click the Number tab, click Date in the Category list, scroll down in the Type list an click 14-Mar-1998. Click OK.
11. Enter the following row titles:

<table>
<thead>
<tr>
<th>Cell</th>
<th>Entry</th>
<th>Cell</th>
<th>Entry</th>
<th>Cell</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>B3</td>
<td>Item</td>
<td>B6</td>
<td>Loan Amt</td>
<td>D4</td>
<td>Monthly Pymnt</td>
</tr>
<tr>
<td>B4</td>
<td>Price</td>
<td>D2</td>
<td>Rate</td>
<td>D5</td>
<td>Total Interest</td>
</tr>
<tr>
<td>B5</td>
<td>Down Pymt</td>
<td>D3</td>
<td>Years</td>
<td>D6</td>
<td>Total Cost</td>
</tr>
</tbody>
</table>

12. Change the width of column A to 0.50 (6 Pixels).
13. Change the width of column B to 10.14 (76 Pixels)
14. Change the width of columns C, D, and e to 12.29 (91 Pixels)
15. Your worksheet should look like the one below. Save the file to your network folder using the name **WeSavU National Bank**.

16. Select the range B2:E6. Right-click the selected range and select Format Cells on the shortcut menu.
17. On the Border tab, select Color – Red, Style – heavy border (column 2, row 6), Presets – Outline; to put a heavy red border around the range. Change the color back to Automatic, Click the Light Border style (column1, row 7), and Click the Vertical Line button to enter a light black vertical border between the cells. Click OK and then click outside the range to deselect it.

**Formatting Cells Before Entering Values**

Usually, you format cells after entering the values. Excel also allows you to format cells before you enter the values, as you will see in the next section.
18. Select the range C4:C6. While holding down the <Ctrl> key, select the nonadjacent range E4:E6. Right-click on one of the selected ranges.
19. Select Format Cells and click the Number tab.
20. Click Currency in the Category list box and then click the fourth format, ($1,234.10), in the Negative numbers list box. This formats the cell values to currency and tells Excel to display negative values within parentheses. Click Ok.
21. Click cell C3 and enter House as the item. With the cell still selected, click the right alignment button.
22. In cell C4 enter 154000 for the Price.
23. In cell C5 enter 32000 for the down payment.
24. In cell E2 enter 8.25% for the interest rate and in cell E3 enter 15 for the number of years. Your worksheet should look like the one below.

<table>
<thead>
<tr>
<th>Item</th>
<th>Rate</th>
<th>Years</th>
</tr>
</thead>
<tbody>
<tr>
<td>Price</td>
<td>154,000.00</td>
<td>15</td>
</tr>
<tr>
<td>Down Pymt</td>
<td>32,000.00</td>
<td></td>
</tr>
<tr>
<td>Loan Amt</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

25. Select the range B4:C6. From the Insert menu select Name and from the submenu select Create.
26. On the Create Names dialog box be sure Left Column is selected and click OK.
27. Select the range D2:E6. From the Insert menu select Name and from the submenu select Create.
28. On the Create Names dialog box be sure Left Column is selected and click OK.

You can now use the names in the range B4:B6 and D2:D6 in formulas to reference the adjacent cells on the right. Excel is not case sensitive on names of cell, so capitalization does not matter. On names that had spaces, such as Down Pymt, Excel replaces the space with an underscore character (_) so the name for cell C6 is down_pymt.

Consider these additional points about names:
a. They can range from 1 to 255 characters in length.
b. If you want to assign a name that is not a text item in an adjacent cell, use the Define command or just type the name in the Name box in the Formula bar.
c. Names are Absolute Cell references. This is important if you are copying a formula using a name.
d. Names display in alpha order in the Name box when you click the Name box arrow. To move quickly to a named cell, just select its name from the list. __Down_Pymt__
e. Names are global to the workbook. A names assigned on sheet 1 can be used on all other sheets of the same workbook.

29. In cell C6 enter the formula =price – down_pymt. The formula displays in cell C6 and on the Formula bar. Press <Enter>. The value $122,000.00 should appear in cell C6.

The next step is to determine the monthly payment using the pmt function. Its general form is =pmt(rate, number of payments, loan amount) where the rate is the interest rate per payment period. The other arguments are self-explanatory. Since the payment period is monthly the interest rate will need to be divided by 12 to get the monthly rate and the number of years will need to be multiplied by 12 to get the number of payments. To display the payment as a positive number, you need to enter a negative sign in front of the loan amount.
30. In cell E4 enter the formula =PMT(rate/12, 12*years, -loan_amt). $1,183.57 should appear in cell E4 as the payment amount. If you have not done so recently, save your file.

31. Next you will calculate the total amount of interest paid and the total cost of the purchase. The total interest is calculated by multiplying the number of payments by the payment amount (12 * years * monthly payment) and subtracting the loan amount. In cell E5 enter the formula =(12 * years * monthly_pymt – loan_amt). $91,042.82 should appear in cell E5.

32. The total amount paid is the down payment plus the total payments made (12*years*payment amount). In cell E6 enter the formula =12 * years * monthly_pymt + down_pymt. The value $245,042.82 should appear in cell E6. Save the worksheet.

With the loan analysis section complete, you can use it to determine the monthly payment, total interest, and total cost for any loan data.

**Entering New Data for a Diamond Ring**

33. In cell C3 type: Diamond Ring
34. In C4 type: 7595
35. In C5 type: 2350
36. In E2 type: 10
37. In cell E3 type: 3 and click outside the cell. Excel automatically recalculates the loan information.

The total cost for the ring should be $8,442.69.

38. Exit Excel without saving. Then reopen the worksheet to return to the original data.

**Using a Data Table to Analyze Worksheet Data**

A data table is a range of cells that shows the answers generated by formulas in which different values have been substituted. You will create a data table to show monthly payment, total interest, and total cost for a list of various interest rates. The interest rates that will be used will range from 7.5 to 10 percent, increasing in increments of ¼%.

39. In cell B7 type: Varying Interest Rate Table
40. Change cell B7 to size 16, red font.
41. Center cell B7 across the range B7:E7. (Hint: See step 5 if you don’t remember how)
42. Enter the column titles as shown below in row 8. They should be centered within their cells.

<table>
<thead>
<tr>
<th>Rate</th>
<th>Monthly Pymt</th>
<th>Total Interest</th>
<th>Total Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.5%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7.75%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8.00%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8.25%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8.50%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8.75%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9.00%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9.25%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9.50%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9.75%</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

43. Adjust rows 7 and 8 to height 27:00 (36.00 Pixels).
44. Next you will create the percent series using the fill handle. In cell B10 type: 7.50% and in cell B11 type: 7.75%.
45. Select the range B10:B11. Drag the fill handle through cell B20 and release. Percentage amounts should automatically fill with cell B20 holding 10.00%. Click outside the range to deselect it.

**Entering the Formulas in the Table**

46. In cell C9 enter the formula: =E4, in cell D9 put: =E5, and in E9 put: =E6. The amounts from those cell should appear.
47. Select the range B9:E20. With the range selected, from the Data menu select Table.
48. When the Table dialog box displays, click in the Column input cell text box (below left) and then click cell E2 to enter its address. Click OK. The table should automatically fill as seen below right.
49. Select the range B8:E20 and apply borders following the same steps as in step 17.
50. Select the range B8:E8. Use the border button on the Formatting toolbar to apply a thick bottom border (column 2, row 2).
51. Select the range C10:E20 and click the Comma Style button on the formatting toolbar. Click outside the range to deselect it. Save your workbook. Your table should look like the one below at this point:

```
<table>
<thead>
<tr>
<th>Varying Interest Rate Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
</tr>
<tr>
<td>-----</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>0%</td>
</tr>
<tr>
<td>1%</td>
</tr>
<tr>
<td>2%</td>
</tr>
<tr>
<td>3%</td>
</tr>
<tr>
<td>4%</td>
</tr>
<tr>
<td>5%</td>
</tr>
<tr>
<td>6%</td>
</tr>
<tr>
<td>7%</td>
</tr>
<tr>
<td>8%</td>
</tr>
<tr>
<td>9%</td>
</tr>
</tbody>
</table>
```

Analyst often look for the row in the data table that agrees with the input cell results. As long as the value in cell E2 matches one of the values in the range B10:B20, one row will match the values in E4:E5 exactly. To make this row stand out, you can use conditional formatting to color the background of the cell in column B that agrees with the input cell (cell E2).

52. Select the range B10:B20. Select Conditional Formatting from the Format menu.
53. When the Conditional Formatting dialog box displays, click equal to in the middle box of the Condition 1 area.
54. Click the box on the right of the Condition 1 area (also called value box 2) and then click in cell E2 of your worksheet.
55. Click the Format button and then select the Patterns tab. Click the color Green (column 4, row 2) on the color palette. Click OK to return to your worksheet. Click outside the range to deselect it. Cell B13 should be green because it matches cell E2.
56. In cell E2 enter 9.25. The green highlight should move to cell B17.
57. Try 11.00 in cell E2. There should be no green highlight.
58. In cell E2 reenter 8.25 to return your worksheet to its previous state. Save your worksheet.

Creating an Amortization Table

An amortization table shows the beginning and ending balances and the amount of the payment that applies to principal and interest for each year over the life of the loan. For example, if the customer wanted to pay off a loan after two years, the amortization table would tell what the payoff would be. In this section you will build an amortization table.

59. Change column widths as indicated: F: 0.50 (6 pixels); G: 3.00 (26 pixels); H, J, and K: 12:29 (91 pixels).
60. In cell G1 type: Amortization Schedule
61. Press <Enter>. Click cell G1. Change the font size to 16 and the font color to Red.
62. Select the range G1:K1 and then click the Merge and Center button to center the title across the range.
63. Enter the column titles in the range G2:K2 as shown below. (Hint: Press <Alt>+<Enter> to enter titles on two lines.

```
<table>
<thead>
<tr>
<th>Amortization Schedule</th>
</tr>
</thead>
<tbody>
<tr>
<td>G</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>Year</td>
</tr>
</tbody>
</table>
```

64. Select the range G2:K2 and then click the Center Alignment button to center the titles within their cells. Click cell G3.
65. Next you will create a series of integers using the fill handle. In cell G3 enter: 1; In cell G4 enter: 2;

### Entering the Formulas in the Amortization Schedule

67. In cell H3 enter the formula: =C6 This sets this cell to the beginning loan balance.

68. In cell I3 you will enter a formula to calculate the present value (PV) of the loan. It will take the form IF(Count <= length of loan, calculate PV, 0 if not). In cell I3 enter the formula: =if(g3 <= $e$3, pv($e$2/12, 12*($e$3 – g3), -$e$4), 0) Be very careful with parentheses.

69. The Paid on Principal is figured by subtracting the Ending balance from the beginning balance. In cell J3 enter the formula: =h3 – i3

70. The interest paid is calculated only if the beginning balance is greater than 0. In cell K3 enter the formula: =if(h3 > 0, 12 * $E$4 – j3, 0). After entering the formulas your worksheet should look like the figure below. It would take $117,702.04 to pay off the loan.

When you enter a formula in a cell, Excel assigns the cell the same format as the first cell in the formula. That is the reason that H3 and J3 are formatted as currency and that I3 and K3 are not.

### Copy the Formulas to Fill in the Table

71. The beginning balance for years 2-15 are based on the previous year’s ending balance. In cell H4 enter the formula: =i3.

72. Select the range I3:K3. Drag the fill handle through row 17 and release.

73. Select cell H4 and drag the fill handle through H17. Your table should now look like the one below.

### Save your work.

### Entering the total formulas in the Table

Next you will enter formulas in rows 18-20. these totals should agree with the totals in the loan analysis section (range B1:E6).

74. In cell i18 enter: Subtotal.

75. Select the range J18:K18 and click the AutoSum button.

76. In cell I19 enter: Down Pymt.

77. In cell i20 enter: Total Cost.

78. In cell K19 enter the formula: =k19 + k18 + j18. The subtotal area should now look like the figure below.

Save your work.
Formatting the table
80. Click cell H3. Click the Format Painter button on the Standard toolbar. Drag through the range I3:K3 to assign the currency format to the numbers.
81. Select the range H4:K17. Click the Comma style button to apply the comma style to the numbers.
82. Select the range G2:K20. Right click the selected range.
83. Select Format cells and click the Border tab.
84. Select Red in the color box. Click Heavy border in the Style area (col 2, row 6). Click the Outline button in the Presets area.
85. Click the Color box arrow again and choose Automatic. Click the Vertical line button in the Border area. Click Ok.
86. Select range G2:K2 and apply a thick bottom border.
87. Select the range G17:K17 and apply a thick bottom border.
88. Your worksheet should look like the one posted. Save your work.

Entering New Loan Data
This worksheet has been designed so that new loan data can be entered and automatically calculated. Try it with the following data:
89. In cell C3 type: 2002 Camaro.
90. In C4 type: 28500.
91. In C5 type: 5500
92. In cell E2 type: 9.50
93. In E3 type: 5
94. Excel automatically recalculates the loan information and regenerates the Amortization Schedule for the new data. Your worksheet should look like the one posted. Close the document without saving the changes.

Adding a Hyperlink to the Workbook
A hyperlink points to the location on which a destination file is stored. It can point to a file on your computer or to another computer (including a Web Server). The destination file can be any Office document of HTML file (Web Page). The link can be text or can be set up as a graphic.
95. Click in cell G18. From the Insert menu choose Picture From File. Navigate to the pdrive clipart folder and select money4.wmf. Resize and reposition as necessary to fit the image within the range G18:H20.
96. When correctly positioned, right-click the image and select Hyperlink. On the Insert Hyperlink dialog box click the File button, Browse to the Data Disk, and select the file wesavu national bank.htm. Click OK if necessary to complete the link.
97. Click outside the graphic to deselect it. Click the graphic to test the link. Internet Explorer should open the WeSavU National Bank web page. Close Internet Explorer and return to Excel.

Protecting the Worksheet
When building a worksheet for novice users, you should protect the cells in the worksheet that you do not want changes, such as cells that contain text and formulas. When you create a new worksheet, all the cells are assigned a locked status, but the lock is not engaged, leaving them unprotected. Unprotected cells are cells whose values users can change at any time. Protected cells are cells that users cannot change.
98. Select the Range C3:C5. Hold down the <Ctrl> key and then select the nonadjacent range E2:E3. Right click one of the selected ranges and select Format cells from the resulting menu.
99. Click the Protection tab. Click the Locked check box to deselect it. This sets these cells to not be locked when sheet protection is turned on.
100. Click outside the range to deselect it.
101. From the Tools men select Protection. Select Protect sheet on the protection submenu. Do not put in a password. Click Ok to turn protection on and return to the sheet. Now only the
cells unlocked in steps 98 and 99 can be changed, keeping your formulas safe. If you try to change any other cell you should get an error message. **Save your work.**

**Goal Seeking to Determine the Down Payment for a Specific Monthly Payment**

102. Click cell E4 (Monthly Payment). From the Tools menu select Goal Seek.
103. When the Goal Seek dialog box displays, type 1000 in the To Value: text box.
104. Click inside the By changing cell: text box and then click cell C5 (down payment). Click OK. Excel recalculates and you should see the Down Payment value changes to $50,922.13, the size of the Down Payment required to lower the payment to $1000. Click Cancel to undo the changes.
105. Exit Excel without saving. Submit your finished file to JCPS Online – WeSavU bank drop box.

**You have finished this exercise.**